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Introducing Pro Tools | SynthCell

Pro Tools | SynthCell™ is a versatile, programmable stereo AAX Native Virtual Instrument plug-in for Pro Tools®. SynthCell supports 
16-bit, 24-bit, and 32-bit floating point audio resolution at sample rates up to 192 kHz.

Pro Tools | SynthCell Features
Pro Tools | SynthCell provides the following key features:

• 32 voice polyphonic synthesizer

• 2 oscillators

• 2 filters

• 8x8 modulation matrix

• Built-in arpeggiator

• Built-in effects

• Custom MIDI CC mapping (MIDI learn) 

Pro Tools | SynthCell
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Working with Plug-ins in Pro Tools
See the Pro Tools Reference Guide (Help > Pro Tools Reference Guide) or Pro Tools online Help (Help > Pro Tools Help) for general 
information on working with plug-ins in Pro Tools, including:

• Inserting plug-ins on tracks

• Clip indicators

• Plug-in Window controls

• Adjusting plug-in controls

• Automating plug-ins

• Using side-chain inputs

• Working with Instrument Plug-ins

• Using Plug-in Presets

• Using Track Presets

System Requirements and Compatibility Information
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. 

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit:

www.avid.com/compatibility

Conventions Used in This Guide
Pro Tools documentation uses the following conventions to indicate menu choices, keyboard commands, and mouse commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse but-
ton

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your Pro Tools system.

Important Notices include information that could affect your Pro Tools project data or the performance of your 
Pro Tools system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid documentation.
 Introducing Pro Tools | SynthCell 2

http://www.avid.com/compatibility


How to Use this PDF Guide
This PDF provides the following useful features:

• The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.

• Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns 
into a finger. Then click to locate to that subject and page.

• All cross references in blue are active links. Click to follow the reference.

• Select Find from the Edit menu to search for a subject.

• When viewing this PDF on an iPad, it is recommended that you open the file using iBooks to take advantage of active links within 
the document. When viewing the PDF in Safari, touch the screen, then touch Open in “iBooks”.

Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you do not have one). Register your 
purchase online, download software, updates, documentation, and other resources.

www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support), download software updates and the latest online manuals, browse the Compatibil-
ity documents for system requirements, search the online Knowledge Base or join the worldwide Avid user community on the User Con-
ference.

www.avid.com/support

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an Avid-certified training center, 
or view video tutorials and webinars.

www.avid.com/education

Videos and Tutorials
Visit the Avid YouTube channel to find playlists and videos that show how to use and learn Pro Tools.

Avid YouTube Channel (all playlists and videos)

Pro Tools Tech Tips (playlist)

Pro Tools Quick Tips (playlist for the Pro Tools Quick Reference Guide, available from the Dashboard)

Products and Developers
Learn about Avid products, download demo software, or learn about our Development Partners and their plug-ins, applications, and 
hardware.

www.avid.com/products
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Installing and Authorizing Pro Tools | SynthCell

Installers for additional plug-ins purchased or rented from the Avid store (shop.avid.com) can be downloaded from your online 
Avid account. These plug-ins are authorized using an iLok license that can be saved to an iLok USB key, iLok Cloud, or on your 
computer.

Installing Plug-ins Bundled with Pro Tools Subscriptions
If you are a new Pro Tools software subscriber, start by downloading and installing the Avid Link app. Avid Link lets you manage 
all of your Avid products and licenses. For more information, refer to the Avid Link documentation online.

Installing Plug-ins from your Avid Master Account
To install the Pro Tools | GrooveCell plug-in:

1 Log in to your Avid Master Account online (my.avid.com).

2 Download the appropriate installer for your operating system (Mac or Windows) from you Avid Master Account. After down-
loading, make sure the installer is uncompressed (.pkg or .exe).

3 Locate and double-click the plug-in installer.

4 Follow the on-screen instructions to complete the installation.

Installing Plug-Ins from the Avid Marketplace
All plug-ins purchased from the Avid Marketplace through Pro Tools are installed silently and—following activation—are avail-
able for use without having to restart Pro Tools.

To install a plug-in from the Avid Marketplace:

1 Launch Pro Tools.

2 Either choose Marketplace > Plug-Ins or select Avid Marketplace from any plug-in insert in your Pro Tools session.

3 Find the plug-in you want in the Avid Marketplace and follow the on-screen instructions.

In the Avid Link preferences, enable the Install Apps Silently option to have all plug-ins to which you are entitled installed au-
tomatically. You will be prompted to enter the administrator username and password for your computer. Additionally, all si-
lently installed applications (such as Pro Tools) and plug-ins with be automatically authorized with your iLok Cloud account. 
If you want to move any of these authorizations to a physical iLok or to your local computer, do so using the iLok License Man-
ager application.

You can also access the Avid Marketplace online at shop.avid.com.
 Installing and Authorizing Pro Tools | SynthCell 4
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About iLok
The plug-ins documented in this guide can be authorized using an iLok USB or USB-C key from PACE Anti-Piracy. Plug-ins may 
also be authorized to iLok Cloud or to your computer using the iLok License Manager application. 

An iLok can hold hundreds of authorizations for all of your iLok-enabled software. After a software license is placed on an iLok, 
you can use the iLok to authorize that software on any computer.

An iLok USB key is not supplied with plug-ins or software options. You can use the iLok included with certain Pro Tools systems, 
or purchase one separately.

Authorizing Avid Audio Plug-Ins
When you purchase a boxed version of an Avid Audio plug-in, you receive an activation code on an activation card. If you purchase 
a plug-in through the Avid Marketplace, the license is deposited directly to your iLok account and you can skip the following pro-
cedure (see Installing Plug-Ins from the Avid Marketplace).

To authorize Avid Audio plug-ins:

1 If you don’t already have an iLok account, visit www.ilok.com to sign up for an account.

2 Visit avid.com/redemption and log into your Avid account. If you do not already have an Avid account, click “Create Your Ac-
count”).

3 Enter your activation code and your iLok.com User ID.

4 Follow the on-screen instructions to deposit your license into your iLok.com account.

5 Once the activation process is complete, the download links for your Avid audio plug-in will be available in the My Products 

section of your Avid account.

6 Download and install the plug-in that you purchased.

7 If you are authorizing a plug-in using an iLok, make sure your iLok is connected to an available USB port on your computer.

8 Launch Pro Tools and follow the on-screen instructions to transfer the plug-in license to your iLok, iLok Cloud, or your com-
puter and authorize the plug-in.

iLok USB-C key (4th generation)

iLok USB key (3rd generation)

For more information, visit the iLok website (www.iLok.com).

If you open a session that uses plug-ins that are not installed and authorized on your system, you are prompted to purchase those 
missing plug-ins though the Avid Marketplace if available.
 Installing and Authorizing Pro Tools | SynthCell 5
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Removing Plug-Ins
If you need to remove a plug-in from your Pro Tools system, follow the instructions below for your computer platform.

Removing Plug-Ins on Mac

To remove a plug-in:

1 Locate and open the Plug-Ins folder on your Startup drive (Library/Application Support/Avid/Audio/Plug-Ins). 

2 Do one of the following:

• Drag the plug-in to the Plug-Ins (Unused) folder.

• Drag the plug-in to the Trash and empty the Trash.

Removing Plug-Ins on Windows

To remove a plug-in:

1 Choose Start > Control Panel.

2 Click Programs and Features.

3 Select the plug-in from the list of installed applications.

4 Click Uninstall.

5 Follow the on-screen instructions to remove the plug-in.
 Installing and Authorizing Pro Tools | SynthCell 6



Pro Tools | SynthCell Controls

Common Controls
Pro Tools | SynthCell provides two separate pages of controls: one for the Main synth controls and another for the built-in Effects. 
Separately, you can switch the lower panel between viewing the controls for the Arpeggiator and the on-screen keyboard.

Main and Effects Pages
Click the Main button to show the main page of controls for the synthesizer. Click the Effects button to show the controls for the 
built-in effects.

Output Level Meter
SynthCell provides a stereo graphic output level meter that includes clipping indicators.

Pro Tools | SynthCell, Main page
 Pro Tools | SynthCell Controls 7



Volume
Adjust the Volume slider to control the output level for the plug-in. The Volume slider is MIDI CC assignable with MIDI CC 7 
(MIDI volume) set as the default.

Arpeggiator (1)
At the bottom of the plug-in window, click tab 1 to show the controls for the built-in 8-step Arpeggiator.

Power

Click the Power button in the upper right corner of the Arpeggiator panel to enable or disable the Arpeggiator.

Hold

Hold functions like a sustain pedal. When enabled, the Arpeggiator continues playing after releasing the keys on your MIDI key-
board controller (MIDI Note Off).

Rate

Set the Rate for the Arpeggiator as a rhythmic value in relation to the Pro Tools session tempo. Options range from quarter note (4) 
to thirty-second note (32) values including triplet and dotted note options.

Swing

Adjust the Swing setting to apply a certain amount of swing rhythmic variation (from 0 to 100%).

Gate

Adjust the Gate setting to set the length of the notes triggered by the Arpeggiator (from 0 to 100%) as a percentage of the Rate.

Mode

Select the Mode for the Arpeggiator pattern from the following options:

Up Plays held notes from lowest to highest.

Down Plays held notes from highest to lowest.

Up+Down Plays held notes from lowest to highest and then back down again.

Up,Down Plays held notes from lowest to highest and then back down again, but repeats lowest and highest.

Zig-Zag Plays held notes in a “zig-zag” pattern: 1st, 3rd, 2nd, 4th note and so on.

Random Plays each of the held notes in a random order.

Rhythmic Random Plays each of the held notes in a random order with random rhythms.

Up 4 Plays held notes from lowest to highest, but restarts every 4 steps.

Up 6 Plays held notes from lowest to highest, but restarts every 6 steps.

Up 8 Plays held notes from lowest to highest, but restarts every 8 steps.

Down 4 Plays held notes from highest to lowest, but restarts every 4 steps.

Down 6 Plays held notes from highest to lowest, but restarts every 6 steps.

Arpeggiator panel

Power button
 Pro Tools | SynthCell Controls 8



Down 8 Plays held notes from highest to lowest, but restarts every 8 steps.

Up 4 Down 4 Plays held notes from lowest to highest and then back down again, but restarts every 4 steps.

Low Up Alt Plays held notes alternating between the lowest note and Up mode.

Low Up Alt 2 Plays held notes alternating between the lowest note and Up mode.

Octave

Select the number of octaves (1, 2, 3, or 4) over which the Arpeggiator pattern is played.

Keyboard (2)
At the bottom of the plug-in window, click tab 2 to show the on-screen keyboard. Click any key to play that note on the synthesizer. 
Click and drag the left “wheel” up or down for Pitch Bend, and click and drag the right “wheel” for Modulation (typically for vi-
brato). The keys and wheels respond to incoming MIDI notes, pitch bend, and mod wheel data.

Pitch Bend Wheel

Click and drag the on-screen pitch bend wheel to bend the pitch up or down. Select the range of the pitch bend wheel in the Global 
Controls (see Pitch Bend).

Modulation Wheel

Click and drag the on-screen modulation wheel (MIDI CC 1) to affect vibrato, pan, tremelo, or the LPF or HPF with the LFO. Select 
what the modulation wheel affects in the Global Controls (see Mod Wheel).

Globals Controls
Max Poly

Select the number of voices for maximum polyphony from 1 to 32 voices.

Pitch Bend

Select the range for Pitch Bend from 0 to 48 semitones.

Mod Wheel

Select the effect of the Mod Wheel: 

– No effect.

Vib Controls vibrato.

Pan Controls Left/Right panning.

Trem Controls tremolo.

LPF Controls the frequency of the master Low Pass Filter (separate from Filters 1 and 2).

HPF Controls the frequency of the master High Pass Filter (separate from Filters 1 and 2).

Keyboard panel
 Pro Tools | SynthCell Controls 9



Rate

Adjust the Rate of the Mod Wheel effect from 0 to 100%.

Glide Mode

Select the Glide Mode: 

Off No Glide.

Legato Legato Glide effect (portamento).

On Linear Glide effect.

Glide Time

Set the Glide Time from 0.0 ms to 5.00 s.

Mono Mode

Select the Mono Mode: 

Poly Polyphonic mode: provides full polyphony up to the number of voices selected for the Max Poly setting.

Retrig Retrigger Monophonic mode: re-triggers the Amplitude Envelope Attack with each MIDI Note On.

Legato Legato Monophonic mode: does not re-trigger the Amplitude Envelope Attack for any MIDI Note On until all notes are off. 

Fine Tune

Set the global Fine Tune between –50 to +50 cents.

Main Page Controls
Click the Main button to show the main controls for the synthesizer.

OSC 1
Oscillator 1 lets you mix several different waveforms, a noise generator, and a sub-oscillator.

Oscillator 1 controls
 Pro Tools | SynthCell Controls 10



Tune

Adjust the tuning of Oscillator 1 between –24 and +24 semitones.

Saw

Adjust the level of a Saw wave from 0–100%. A sawtooth wave sound is harsh and clear, and its spectrum contains both even and 
odd harmonics. It is particularly useful for creating leads and aggressive string-like sounds.

Pulse

Adjust the level of a Pulse wave from 0–100%. The Pulse wave length can be modified by adjusting the PWM control: at 50% it 
is a square wave, at 0% it is an impulse, and at 100% a rectangle wave. Square waves consist of odd harmonics and are useful for 
emulating woodwind instrument–like sounds.

Tri

Adjust the level of a Triangle (Tri) wave from 0–100%. Like a square wave, a triangle wave contains only odd harmonics. However, 
the higher harmonics roll off much faster than with a square wave.

PWM

Adjust the amount of Pulse Width Modulation (PWM) from 0–100%. This affects the width (duty cycle) of the Pulse wave oscil-
lator. At 50% the Pulse wave oscillator produces a square wave.

Noise

Adjust the level of the Noise generator (white noise) from 0–100%.

Sub

Adjust the level of the Sub-oscillator (a square wave an octave lower) from 0–100%.

Multi

Multiplies the number of Saw oscillators per voice for Oscillator 1 from none (–) up to x7. Use this setting in conjunction with the 
Detune control to thicken or “fatten” the sound.

Detune

Adjust the Detune control to detune the multiple saw oscillators from one another between 0–100%. This control has no effect if 
Multi is set to none (–).

OSC 2
Oscillator 2 lets you mix Saw and Pulse waveforms.

Oscillator 2 controls
 Pro Tools | SynthCell Controls 11



Tune

Adjust the tuning of Oscillator 2 between –24 and +24 semitones.

Saw

Adjust the level of a Saw wave from 0–100%.

Pulse

Adjust the level of a Pulse wave from 0–100%.

PWM

Adjust the amount of Pulse Width Modulation (PWM) from 0–100%. This affects the width (duty cycle) of the Pulse wave oscil-
lator. At 50% the Pulse wave oscillator produces a square wave.

Fine Tune

Adjust the Fine Tune for Oscillator 2 between –50 to +50 cents. Slightly detuning Oscillator 2 against Oscillator 1 can create a 
warmer, richer tone when mixing both oscillators together.

Filter 1
Filter 1 processes the output of both Oscillator 1 and 2.

Power

Click the Power button in the upper right corner of the Filter 1 panel to enable or disable the filter.

Mode

Choose one of the following filter types:

HP12 12 dB per octave high pass filter.

BP12 12 dB per octave band pass filter.

LP6 6 dB per octave low pass filter.

LP12 12 dB per octave low pass filter.

LP18 18 dB per octave low pass filter.

LP24 24 dB per octave low pass filter.

Filter 1 controls
 Pro Tools | SynthCell Controls 12



Cutoff

Adjust the Cutoff frequency of the filter from 20 Hz to 25.00 kHz

Res

Adjust the resonance of the filter from 0–100%.

Key

Adjust how much the keyboard (pitch) affects the Cutoff frequency of the filter from 0–100%.

Env

Adjust how much the Filter Envelope affects the Cutoff frequency of the from –100% (inverted envelope) to +100%. The default 
setting is 0% (no affect).

Filter 2
Filter 2 is applied to the signal path after Filter 1.

Power

Click the Power button in the upper right corner of the Filter 2 panel to enable or disable the Filter.

Mode

Choose one of the following filter types.

HP12 SVF 12 dB per octave state variable high pass filter.

HP12 MS 12 dB per octave high pass filter that emulates the filter of a popular, patchable semi-polyphonic synthesizer from the late 
70s.

BP12 SVF 12 dB per octave state variable band pass filter.

LP12 SVF 12 dB per octave state variable low pass filter.

LP12 MS 12 dB per octave low pass filter that emulates the filter of a popular, patchable semi-polyphonic synthesizer from the late 
70s.

Notch Notch filter where the Res setting controls the notch width.

Comb + Positive comb filter that adds a delayed copy of the signal resulting in a series of peaks/notches.

Comb – Negative comb filter that subtracts a delayed copy of the signal resulting in a series of notches/peaks

Filter 2 controls
 Pro Tools | SynthCell Controls 13



Cutoff

Adjust the Cutoff frequency of the filter from 20 Hz to 25.00 kHz.

Res

Adjust the resonance of the filter from 0–100%.

Key

Adjust how much the keyboard (pitch) affects the Cutoff frequency of the filter from 0–100%.

Env

Adjust how much the Filter Envelope affects the Cutoff frequency of the filter from –100% (inverted envelope) to +100%. The de-
fault setting is 0% (no affect).

Filter Envelope
The Filter Envelope can applied to Filters 1 and 2. Adjust the Env control for each filter to determine how much the Filter Envelope 
affects the Cutoff frequency of the filter.

ADSR Graph

The ADSR Graph provides a visual representation of the envelope. You can click and drag on any of the breakpoints to change the 
Attack, Decay, Sustain, and Release settings.

Attack

Adjust the A control to set the duration of the attack portion of the envelope from 0 ms–16.00 s.

Decay

Adjust the D control to set the duration of the decay portion of the envelope from 0 ms–16.00 s.

Sustain

Adjust the S control to set the level of the sustain portion of the envelope from 0–100%.

Release

Adjust the R control to set the duration of the release portion of the envelope from 0 ms–16.00 s.

Velocity

Adjust the Vel control to set how much MIDI note velocity affects the level of the envelope from 0–100%.

Filter Envelope controls
 Pro Tools | SynthCell Controls 14



Amp Envelope
The Amplitude Envelope shapes the level of each note from MIDI Note On to MIDI Note Off.

ADSR Graph

The ADSR Graph provides a visual representation of the envelope. You can click and drag on any of the breakpoints to change the 
Attack, Decay, Sustain, and Release settings.

Attack

Adjust the A control to set the duration of the attack portion of the envelope from 0 ms–16.00 s.

Decay

Adjust the D control to set the duration of the decay portion of the envelope from 0 ms–16.00 s.

Sustain

Adjust the S control to set the level of the sustain portion of the envelope from 0–100%.

Release

Adjust the R control to set the duration of the release portion of the envelope from 0 ms–16.00 s.

Velocity

Adjust the Vel control to set how much MIDI note velocity affects the level of the envelope from 0–100%.

Mod LFO
The Mod LFO (Low Frequency Oscillator) ...

Wave

Select one of the following waveforms for the LFO.

Sin Sine wave.

Tri Triangle wave.

Sqr Square wave.

Sqr Up Square wave up waveform is the inverse (low to high to low to high) of a regular square wave (high to low to high to low).

Amplitude Envelope controls

Modulation LFO controls
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Saw Sawtooth wave with a down ramp.

Saw Up Sawtooth wave with an up ramp.

Saw Exp Sawtooth wave with an exponential down ramp.

S+H Sample and hold.

Drift Drift is a smoothly rounded random signal, like sample and hold but with the steps rounded off.

Rate

Set the Rate of the LFO. When Sync is disabled, Rate can be set from 0.01–100.0 Hz. When Sync is enabled, the values for the 
Rate settings are measured as fractions or multiples of a quarter-note: where 1.00 is a quarter-note, 0.50 is an eighth-note, 2.00 is 
a half-note, and so on.

Sync

Enable Sync to synchronize the LFO to the Pro Tools tempo.

Retrig

Enable Retrig to re-trigger the start of the LFO with every MIDI Note On.

Mod Env
The Mod Env provides a variable ramp generator that can be used to modulate other parameters of the synthesizer.

Mode

Select one of the following ramp shapes for the Modulation Envelope:

Lin A-D Linear Attack and Decay.

Log A-D Logarithmic Attack and Decay.

Exp A-D Exponential Attack and Decay.

Lin A-R Linear Attack and Release.

Log A-R Logarithmic Attack and Release.

Exp A-R Exponential Attack and Release

Attack

Adjust the A control to set the duration of the attack portion of the Modulation Envelope from 0 ms–16.00 s.

Decay

Adjust the D control to set the duration of the decay (or release) portion of the Modulation Envelope from 0 ms–16.00 s.

Modulation Envelope controls
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Mod Matrix
The Modulation Matrix lets you modulate any of the available Destination controls by any available Source. You can modulate 
up to 8 Destination controls.

Source

Select the desired modulation Source:

Constant Offsets the destination by a constant amount determined by the Depth setting.

Velocity MIDI velocity.

Key MIDI note number.

Pitch Bend MIDI pitch bend.

Mod Wheel MIDI CC 1.

Aftertouch MIDI aftertouch.

MPE Timbre MIDI CC 74, which is usually sent from the y-axis of MPE (as well as typically being the MIDI CC for filter cutoff).

Random Generates random bi-polar numbers each time a note is played.

Ramdom + Generates random positive numbers each time a note is played.

Alternate Alternates between 0 and the maximum value (determined by the Depth setting) with each note played so that every other 
note is modulated.

Legato Generates 0 for notes that are played with no other note held, and the maximum value (determined by the Depth setting) 
for notes played while any other note is held.

Wheel LFO The LFO signal applied by the modulation wheel (MIDI CC 1) and used by the Mod Wheel Destination parameter

Mod LFO Modulation LFO.

Mod Env Modulation envelope.

Filt Env Filter envelope.

Amp Env Amplitude envelope.

Depth

Adjust the Depth of the modulation applied to the Destination from 0–100%.

Destination

Select the desired modulation Destination (where – is none).

Modulation Matrix controls
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Effects Page Controls
Click the Effects button to show the effects controls.

Reverb

Power

Click the Power button in the upper right corner of the Reverb panel to enable or disable the Reverb effect.

Mode

Select one of the following Reverb options:

Small Emulates a small room.

Room Emulates a medium room.

Chapel Emulates a medium chapel space.

Hall Emulates a medium hall.

Large Hall Emulates a large hall.

Stadium Emulates a large stadium.

Outer Space Way out reverb.

Deep Space Big, vast reverb.

Digital Digital reverb (a la 80s).

Left Right Panning reverb.

Reverse Reverse reverb.

Gated Gated reverb.

Mix

Adjust the Mix control to set the balance of dry versus wet (effected) signal from 0–100%.

Time

Adjust the reverb time as percentage of the selected Mode from –100 to +100%.

Effects page
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Modulation

Power

Click the Power button in the upper right corner of the Modulation panel to enable or disable the Modulation effect.

Mode

Select one of the following Modulation effect options:

Chorus Tri Chorus with triangle LFO resulting in steady detuning.

Chorus Sine Chorus with sine LFO resulting in undulating detuning.

Chorus Random Chorus with random LFO resulting in ensemble-like detuning.

Flanger Flanger effect.

Phaser Phaser effect.

Mix

Adjust the Mix control to set the balance of dry versus wet (effected) signal from 0–100%.

Rate

Adjust the Rate of modulation from 0.10 Hz–10.00 Hz.

Depth

Adjust the Depth of modulation from 0–100%.

Delay

Power

Click the Power button in the upper right corner of the Delay panel to enable or disable the Delay effect.

Mode

Select one of the following Delay options:

Straight Equally spaced repetition.

Spread Slightly different left and right delay times to create a stereo spread.

Ping Pong Alternating left and right delays.

L/R Straight Left delay time is half of the right delay time.

L/R Triplet Left delay time is two-thirds of the right delay time.

L/R Dotted Left delay time is three-quarters of the right delay time.

Thin Delay with a low-cut filter.

Dark Delay with a high-cut filter.

Tape Delay with both low-cut and high-cut filters, and also “wow” and “flutter.”

L/R Tape Like Tape delay, but with a ping pong effect.

Rise 3 Repeating pattern of three delays from soft to loud.

Rise 4 Repeating pattern of four delays from soft to loud.

L L R R Alternating delays between two left then two right.

Circles Quasi-random pattern of left and right delays.
 Pro Tools | SynthCell Controls 19



Gallop Rhythmic delay pattern with gaps.

Offbeat Rhythmic delay pattern on the offbeats relative to the input.

Trance 1 Delay pattern of dotted intervals.

Trance 2 Alternative delay pattern of dotted intervals.

Flit Up 3 Repeating pattern of three delays with a rising cutoff filter.

Flit Down 3 Repeating pattern of three delays with a descending cutoff filter.

Flit Up 4 Repeating pattern of four delays with a rising cutoff filter.

Flit Down 4 Repeating pattern of three delays with a descending cutoff filter.

Mix

Adjust the Mix control to set the balance of dry versus wet (effected) signal from 0–100%.

Time

The delay time always synchronizes to the Pro Tools session tempo. The following rhythmic values are available: 1/2, 1/4D (dot-
ted), 1/2T (triplet), 1/4, 1/8 D (dotted), 1/4 T (triplet), 1/8, 1/16 D, 1/8 T, 1/16, 1/32 D, 1/16 T, 1/32. 1/8 is selected by default. 

Feedback

Adjust the Feedback of the delay from 0–100%.

Distortion

Power

Click the Power button in the upper right corner of the Distortion panel to enable or disable the Distortion effect.

Mode

Select any of the following distortion options:

Clip Emulates hard (transistor) clipping.

Tube Emulates soft (vacuum tube) overdrive.

Distort Emulates diode-modeled distortion like in many distortion pedals.

Rectify Inverts negative parts of waveform to positive.

Lo-Fi Reduces the sample rate and bit depth of the signal for a “low-fidelity” distortion effect.

Crush Like Lo-Fi, but more digital sounding (like a “bit-crusher”).

Freq

Adjust the distortion frequency from 1.00 kHz to 20.00 kHz.When Mode is set to Lo-Fi or Crush, the Freq setting controls the re-
sampling rate (sample rate reduction). For any other Mode settings it controls high frequency tone damping, like a “brightness” 
control.

Drive

Adjust the Drive (gain) of the distortion from 0–100%.

Mix

Adjust the Mix control to set the balance of dry versus wet (effected) signal from 0–100%.
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Assigning MIDI CC
Pro Tools | SynthCell lets you assign MIDI CC to most of its controls.

To assign MIDI CC to a control:

1 Insert SynthCell on an Instrument track.

2 Assign an external MIDI device to the MIDI Input on the Instrument track.

3 Record enable the Instrument track on which SynthCell is inserted.

4 Right-click on the control you want in SynthCell and choose Learn MIDI CC. The name of the control is indicated in the pop-up 
menu (for example, “Filt 1 Cutoff”).

5 Move the continuous controller on your external MIDI device (such as a knob, slider, or foot pedal) that you want to assign to 
the control.

Now when you right-click on the control, the assigned MIDI CC is indicated under the name of the control in the pop-up menu (for 
example, MIDI CC 1).

To assign a new MIDI CC to an already assigned control:

1 Right-click on the assigned control in SynthCell that you want to change.

2 Choose Assign New CC.

3 Move a different continuous controller on your external MIDI device.

To remove MIDI CC assignment from an assigned control:

1 Right-click on the assigned control in SynthCell that you want to unassign.

2 Choose Remove Assignment.

Learn MIDI CC for the Cutoff frequency control for Filter 1

You can also assign MIDI CC control from the Instrument track on which SynthCell is inserted or from another MIDI track 
assigned to control SynthCell.

MIDI CC 1 assigned to the Cutoff frequency control for Filter 1
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Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com

https://www.avid.com/learn-and-support
https://www.avid.com
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